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1. ЦЕЛЬ ЛАБОРАТОРНОЙ РАБОТЫ 
1. Ознакомление с принципом работы дальномера, использующего метод 

частотной модуляции. 
2. Изучение структурной схемы частотного радиодальномера и измерение 

его параметров. 
3. Закрепление теоретических сведений о радиотехнических системах (РТС) 

данного типа. 

2. КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 
 
Определение дальности радиотехническими методами производится в ре-

зультате измерения времени τ = 2R/c прохождения сигналом расстояния от РЛС 
до цели и обратно (рис. 1). Время запаздывания τ может измеряться: а) непосред-
ственно при фиксации моментов излучения и приема сигнала; б) посредством 
измерения разности фаз между гармоническими колебаниями, которые выде-
ляются из излучаемого и принимаемого сигналов; в) посредством измерения 
разности частот излучаемого и принимаемого сигналов. В соответствии с тем, 
какой из указанных параметров сигнала  измеряется при   определении дально-
сти,    различают: а) временной (импульсный); б) фазовый или в) частотный ме-
тоды измерения дальности. 

 
 
 

Рис. 1. Схема распространения сигнала до цели и обратно 
 

Частотный метод измерения дальности основан на использовании час-
тотной модуляции излучаемых непрерывных сигналов. 

При частотном методе измерения дальности (рис. 2, а) излучается непрерыв-
ный сигнал, частота которого fизл  изменяется по пилообразному закону (рис. 2 б, в). 
Если цель неподвижна (R = const), то частота принимаемого сигнала fпр изменя-
ется по тому же закону, но с запаздыванием на τ = 2R/с. Разность частот прини-
маемого и излучаемого сигналов fб (частота биений) на линейных участках из-
менения этих частот определяется равенством 
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c
R

dt
df

dt
dffб

2
⋅==τ , 

где 
t
f

∂
∂ – скорость изменения частоты излучаемого сигнала. 

Если Δfм – девиация частоты передатчика, Tм = 1/Fм – период модуляции 
излучаемых колебаний, то df/dt = 2 Δfм /Tм  = 2 ΔfмFм . Следовательно, 

c
RFf

Tc
Rff мм

м

м
б

∆
=

∆
=

44 .                                                (1) 

Из  последнего выражения следует,  что при  измеренной  частоте биений 
дальность объекта может быть определена по формуле 

мм

б

м

мб

Ff
fc

f
TfcR

∆
=

∆
=

44
 .                                                  (2) 

 

 
Биения формируются в смесителе, на который подается принимаемый и 

ослабленный аттенюатором излучаемый сигнал. После усиления биения посту-
пают в частотный анализатор (частотомер), шкала которого отградуирована не-
посредственно в единицах дальности. 

 

Рис. 2. Схема частотного радиодальномера (а), законы изменения частоты  
излучаемых и принимаемых колебаний и биений для неподвижных (б) 

и подвижных (в) целей 
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При фиксированной дальности объекта частота биений остается постоян-
ной лишь на линейных участках изменения частот излучаемого и принимаемого 
сигналов. Это обстоятельство является существенным, и его необходимо учиты-
вать при выборе параметров дальномера. Рассмотрим этот вопрос более детально, 
однако без строгого обоснования приводимых соотношений [1]. 

Если цель неподвижна, то вследствие периодичности излучаемых и при-
нимаемых колебаний сигнал биений, выделяемый на выходе смесителя, также 
является периодическим с периодом повторения Тп. Следовательно, спектр бие-
ний − линейчатый со спектральными линиями, расположенными на шкале час-
тот в точках f = kFм, k = 1, 2, ... . В рассматриваемом дальномере выполняется 
условие Тм > 2 R max/ с , которое является необходимым для его нормальной рабо-
ты. При этом условии основная энергия сигнала биений содержится в спектраль-
ной составляющей, частота которой наиболее близка к fб. Частотным анализато-
ром будет зафиксирована именно эта частота, близкая, но в общем случае не 
равная величине fб, которая определяется формулой (1). 

Разность Δ между фиксируемой анализатором частотой и частотой биений 
fб, которая входит в расчетную формулу (2), вызывает ошибку измерения даль-
ности. Разность Δ является случайной величиной, равномерно распределенной в 
интервале (–0,5 Fм, 0,5 Fм). 

Частотный анализатор, являющийся оконечным устройством частотного 
дальномера, может быть либо последовательным, либо параллельным. После-
довательный анализатор представляет собой узкополосный фильтр, перестраи-
ваемый по частоте. Когда фильтр оказывается настроенным на частоту биений, 
на его выходе появляется сигнал. Дальность объекта определяется по частоте 
настройки фильтра в момент появления сигнала на его выходе. В течение 
большей части времени перестройки фильтр оказывается расстроенным отно-
сительно сигнала биений, хотя этот сигнал поступает на его вход. Таким обра-
зом, время накопления сигнала цели в фильтре существенно меньше его про-
должительности. Это существенный недостаток последовательного спектроа-
нализатора, поскольку при его использовании большая часть энергии прини-
маемого сигнала теряется и энергетические потери при приеме приходится вос-
полнять увеличением мощности излучаемого сигнала. 

Параллельный спектроанализатор представляет собой набор некоторого 
числа NR узкополосных фильтров, перекрывающих диапазон возможных значе-
ний частот биений. Частота биений определяется по частоте настройки того уз-
кополосного фильтра, на выходе которого появляется сигнал. Потерь энергии 
принимаемого сигнала в этом случае нет, поэтому параллельный частотный 
анализатор энергетически более выгоден. Однако такой анализатор является 
значительно более сложным по сравнению с последовательным спектроанали-
затором [3]. 

Если в зоне облучения частотного дальномера находится несколько це-
лей, то каждой цели соответствует определенная частота биений и все эти час-
тоты фиксируются спектроанализатором дальномера. Минимальная разность 
частот биений двух целей, при которой эти частоты могут быть раздельно за-
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фиксированы анализатором, равна Fм. Этой разности соответствует разность 
расстояний ΔR = с/4Δfм, характеризующая разрешающую способность частот-
ного дальномера по дальности. Таким образом, точность и разрешающая спо-
собность частотного дальномера определяются девиацией частоты Δfм, т. е. ши-
риной спектра излучаемого сигнала. 

Особенность частотного дальномера состоит в том, что при движении цели 
вследствие эффекта Доплера возникает дополнительное смещение частоты при-
нимаемых колебаний относительно частоты излучаемых колебаний (рис. 2, в). 
При условии Δfм << fизл, которое всегда выполняется, это смещение можно счи-
тать постоянным за период модуляции. Из рис. 2 видно, что доплеровское сме-
щение частоты Fд приводит к тому, что частота биений fб1, в течение одного по-
лупериода модуляции не равна частоте биений fб2 в течение второго полупе-
риода. Если fб – частота биений при неподвижной цели, то в случае подвижной 
цели, находящейся на той же дальности, fб1= fб+ Fд, fб2= fб – Fд. Отсюда fб = 0,5 
(fб1 + fб2), Fд = 0,5 (fб1 – fб2). Приведенные соотношения справедливы только при 
симметричном пилообразном законе модуляции. Они позволяют определить 
частоты fб и Fд, т. е. дальность и радиальную скорость цели, путем измерения 
частот биений fб1 и fб2. 

  
Однако частотомер, работающий по принципу измерения числа периодов 

(временной метод), измеряет не fб, а среднее значение fбср , которое определяет-
ся, как высота прямоугольника,  равновеликого площади огибающей частоты 
биений (рис. 3). Огибающая частоты биений представляет собой трапецию. 
Площадь трапеции равна [4]: 







 −+= з

ммб
abcd tTTfS

222
.                                         (3) 

Площадь равновеликого прямоугольника 
2''
м

бddaa
TfS = . 

Приравнивая правые части выражений для площадей и решая уравнение 
относительно fбcp, получаем 









−=

м

з
ббср T

tff 1 .                                                 (4) 

Данная ошибка относится к разряду методических ошибок и обусловли-
вает абсолютную погрешность в измерении дальности на величину 

a

b c

d

|fб(t)|

t
 

Рис. 3. Огибающая частоты биений 
 

Би
бл
ио
те
ка

 БГ
УИ
Р



 8 

м

зб

ммм

зб

мм

б
б f

tсf
TFf

tсf
Ff
сffR

∆
=

∆
=

∆
∆

=∆∆
444

)(  .                           (5) 

Соответственно относительная ошибка измерения дальности составляет 

( ) зм
бм

ммзбб
б tF

cff
Fftсf

R
fRf =

∆
∆

=
∆∆

=∆
4

4)(
δ .                           (6) 

Как следует из этого выражения, ( )бf∆δ пропорциональна tз и Fм. Таким 
образом, чем больше tз и Fм, тем больше ( )бf∆δ . 

Максимальная задержка tз max  и максимальная частота модуляции Fм max 
выбираются  из условия  обеспечения  однозначного  измерения дальностей во 

всем диапазоне изменения рабочих дальностей [4]. При tз max, равном 
2
мT , fб max 

равно ΔfM. В результате максимальная дальность 

ммм

м

мм

б

F
c

Ff
fс

Ff
cfR

444
max

max =
∆

∆
=

∆
= .                                  (7) 

Второй причиной, вызвавшей ошибку измерения дальности, является дис-
кретность отсчета. 

Так, в случае применения для измерения fб анализатора спектра, дискрет-
ность отсчета обусловлена дискретностью спектра преобразованного сигнала. 

Поясним сказанное. Вначале рассмотрим преобразованный сигнал (сиг-
нал на выходе смесителя) без учета скачкообразного изменения фазы на 180° 

через равные промежутки времени 
2
мT  (гипотетический случай). В этом случае 

длительность импульса τи равна периоду модулирующей функции Тм. Ампли-
тудно-частотный спектр такого сигнала будет состоять из одной спектральной 
линии. Остальные спектральные линии, кратные Fм, совпадают с нулевыми зна-
чениями огибающей спектра (считаем, что радиоимпульс является прямоуголь-
ным). Изменение дальности будем приводить к дискретному смещению fб по 
оси частот. Минимальный интервал, через который может быть зафиксировано 
следующее значение частоты биений, равен Fм. Это обстоятельство и является 
причиной ошибки в измерении дальности. Кроме того, это обстоятельство на-
кладывает ограничения и на fб min, которые равны Fм. В результате получим  

ммм

м

мм

б

f
c

Ff
Fс

Ff
cfR

∆
=

∆
=

∆
=

444
min

min .                                  (8) 

В основу способа уменьшения ошибки измерения дальности, обуслов-
ленной дискретностью счета, может быть положено использование сложной 
модулирующей функции, состоящей из нескольких функций.  В радиовысото-
мере РВ5 она состоит из двух функций: Fm1 – основной и Fm2 –  дополнительной. 
Причем Fm1 » Fm2. 

В   результате   использования   Fm1 и Fm2 – результирующий модулирую-
щий сигнал приобретает сложную форму (рис. 4), период повторения которого 
определяется периодом вспомогательной функции Fm2. Вследствие этого ин-
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тервал между спектральными линиями спектра преобразованного сигнала будет 
равен Fm2. В результате ошибка измерения дальности уменьшится во столько 
раз, во сколько Fm1 > Fm2, и может быть оценена с помощью следующего выра-
жения: 

1

2

4
)(

мм

м
б Ff

сFfR
∆

=∆∆ .                                                  (9) 

 

 
К недостаткам частотного метода дальнометрии относятся: сложность 

аппаратуры при дальнометрии многих объектов, что обусловлено необходимо-
стью применения громоздкого параллельного спектроанализатора; трудность 
эффективной развязки приемного и передающего трактов, необходимой для 
нормальной работы дальномера; высокие требования к линейности изменения 
частоты излучаемых колебаний при дальнометрии многих объектов. 

Основные достоинства частотного метода измерения дальности – это ма-
лая пиковая мощность излучаемого сигнала по сравнению с мощностью при 
импульсном методе при высокой точности измерения и разрешающей способ-
ности по дальности, а также возможность измерения очень малых дальностей. 

Отмеченные достоинства и недостатки частотного метода измерения даль-
ности предопределили его использование в радиовысотомерах малых высот. 
При этом измеряется дальность до единственного объекта (поверхности суши 
или воды) и вместо частотного анализатора используется простой счетчик числа 
выбросов напряжения биений в единицу времени.  

Показания радиовысотомера не зависят от покрова местности и атмо-
сферных условий (температуры, влажности и т.п.). Отдельные крупные строе-
ния, возвышенности, овраги, берега рек и озер отмечаются на указателе высоты  
соответствующими изменениями показаний высоты. 

 

 

t

Um(t)

Tm1

Tm2

 
 

Рис. 4. Огибающая частоты биений при использовании двух 
модулирующих частот  
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Радиовысотомером затруднительно пользоваться при полетах над горной 
местностью вследствие резких изменений расстояний от летящего самолета до 
земли, которые могут превышать диапазон измеряемых высот. 

При значительных продольных и поперечных кренах самолета (более 30°) 
показания радиовысотомера становятся ошибочными (особенно при полетах 
над пересеченной местностью) и пользоваться им в этих случаях не  рекомен-
дуется. 

При дальнометрии одного объекта частота излучаемого сигнала может 
изменяться по синусоидальному или другому, необязательно пилообразному 
закону, что значительно упрощает аппаратуру. 

Достоинства частотного метода измерения дальности: 
• возможность измерять очень малые дальности; 
• использование маломощного передатчика; 
Недостатки: 
• необходимо использование двух антенн; 
• ухудшение чувствительности приемника вследствие просачивания в 

приемный тракт через антенну излучения передатчика, подверженного случай-
ным изменениям; 

• высокие требования к линейности изменения частоты. 
Основные тактико-технические данные радиовысотомера малых высот 

типа РВ-УМ: 
1. Диапазон измеряемых высот ................................................от 0 до 600 м. 
2. Точность измеряемой высоты в диапазоне 0 – 600 м.........± 5 м, ± 8 % Н. 
3. Средняя частота генератора СВЧ.......................................... 444 ± 6 МГц. 
4. Полоса модуляции ................................................................... 17 ± 2 МГц. 
5. Излучаемая мощность........................................................не менее 0,2 Вт. 

3. СРЕДА ПРОЕКТИРОВАНИЯ 
Исследование частотного радиодальномера проводится в среде Advanced 

Design System (ADS) фирмы Agilent Technologies, которая представляет собой 
одну из самых мощных систем проектирования с расширенными возможно-
стями. Среда проектирования имеет оконный интерфейс. Все операции осуще-
ствляются внутри рабочей области текущего окна [2]. 

3.1. Основы интерфейса ADS 
Главное окно, называемое Advanced Design System (Main), содержит 

главное меню и панель инструментов для быстрого доступа к основным опера-
циям. Необходимые данные представлены в виде дерева каталогов, где показа-
на иерархия текущего проекта (рис. 5). 
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Из главного окна можно создавать проекты и управлять проектами верх-
него уровня и схемами; устанавливать набор необходимых пунктов меню; кон-
фигурировать панели инструментов и назначать горячие клавиши; выбирать 
типы компонентов, загружаемых во время запуска пакета; воспроизводить мак-
росы, созданные с помощью встроенного языка (Application Extension Language – 
AEL); формировать AEL-команды; запускать текстовый редактор; открывать 
окно вывода результатов (Data Display Window) и др. 

 
Перед тем как начать работать с приложениями, необходимо выбрать тип 

проекта: Analog/RF, Digital Signal Processing или Both. Тип Analog/RF опреде-
ляет работу в подсистеме моделирования аналоговых устройств. Тип Digital 
Signal Processing или Both задает работу в подсистеме проектирования цифро-
вых устройств Ptolemy. Кроме того, тип Both используется для проектирования 
смешанных аналого-цифровых устройств. Уже созданный проект может рабо-
тать только при совпадении текущего типа проекта с типом, определенным при 
создании проекта. Можно изменить эти опции, используя пункт меню Tools → 

Рис. 6. Окно проектов 
 

 
Рис. 5. Главное окно среды проектирования 
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Advanced Design System Setup в главном окне, при этом необходимо перезагру-
зить систему. 
          При загрузке ADS также открывается выпадающее окно проектов (рис. 6). 
Назначение кнопок панели инструментов показано на рис. 7. 

 
 

Файлы с примерами проектов можно открыть несколькими способами. 
Первый способ – выбрать кнопку которая находится в главном окне 

Advanced Design System (окно проектов). Откроется окно файлов с примерами 
проектов (рис. 8). 

 
Второй способ – выбрать кнопку , которая находится в окне Advanced 

Design System (Главное меню). Откроется окно файлов с примерами проектов. 
Чтобы открыть файл проекта из примеров к программе Advanced Design 

System, необходимо выбрать из списка нужный проект и дважды щелкнуть на 
его имени левой кнопкой мыши. 

3.2. Окно схемного редактора 
Окно схемного редактора содержит заголовок, меню, панель инструмен-

тов, панель быстрого доступа к необходимым компонентам и область проекти-

 
Рис. 8. Окно примеров проектов 

 

Рис. 7. Главное меню и панель инструментов 
 

Развертывание 
всех окон 

Создание новых окон Schematic, 
Layout и отображения данных 
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рования схемы. В окне схемного редактора можно создавать и редактировать 
схему проекта, задавать переменные и уравнения, моделировать, открывать ок-
но вывода результатов (рис. 9). 

 
Рис. 9. Окно схемного редактора 

 
В строке «Название проекта» указаны тип окна, тип проекта, имя файла и 

число-идентификатор, которое показывает, какое по счету окно проекта загру-
жено. В главном меню отображаются пункты меню, доступные в данном редак-
торе. Выпадающее меню компонентов позволяет выбирать категорию компо-
нентов, отображаемых в списке палитры. Выпадающее меню «История компо-
нентов» содержит список компонентов, которые уже были использованы в дан-
ном сеансе работы. 

Рабочая область (область проектирования) – область, где располагается 
проект. 

Перечень компонентов содержит кнопки компонентов для размещения их 
в рабочей области окна. 

В строке «Быстрые сообщения» появляются сообщения о тех или иных 
командах, используемых в течение рабочего сеанса. 

Для открытия уже созданной схемы в меню File или File Brower следует 
выбрать имя нужного файла. 

В окне схемного редактора создается схема проекта. Панель инструмен-
тов окна схемного редактора показана на рис. 10. 

 
Рис. 10. Панель инструментов окна схемного редактора 
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Кнопки панели инструментов окна схемного редактора имеют следующее 
назначение: 

 – создание новой схемы; 
 – открытие имеющейся схемы; 
 – сохранение текущей схемы; 
 – печать текущей схемы; 
 – окончание выполнения команды и возврат к выбранному режиму; 
 – передвижение объекта; 
 – копирование объекта; 
 – удаление объекта; 
 – возврат к предыдущему шагу; 
 – отмена изменения точки входа; 
 – просмотр всей схемы; 
 – масштабирование указанной области; 
  – масштабирование относительно указанной точки; 
  – увеличение в 2 раза; 
  – уменьшение в 2 раза; 
  – крупный (панорамный) вид указанного объекта; 
  – развертывание иерархии объекта; 
 –  свертывание иерархии; 
 –  вращение объекта по часовой стрелке; 
 –  зеркальное отображение объекта относительно оси x; 
 –  зеркальное отображение объекта относительно оси y; 
 –  деактивация или активация объекта; 
 –  интеллектуальное моделирование; 
 – вставка порта (вход системы); 
 –  вставка элемента заземления; 
 –  вставка переменной величины; 
 –  обращение к библиотеке компонентов; 
 – изменение параметров компонента; 
 – вставка (соединение) проводника; 
 – вставка названия провода; 
 – моделирование (симуляция); 
 – настройка параметров; 
 – открытие нового окна отображения данных; 
 – запуск сервиса обработки данных из файла. 

 
Схема создается размещением компонентов, портов, источников данных, 

модулей, переменных и т. д. При запуске программы загружается набор биб-
лиотек и компонентов по умолчанию. Можно также конфигурировать загру-
жаемые опции, при этом наиболее удобно выбирать тип проекта при старте сис-
темы ADS. 
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Параметры компонентов можно редактировать, когда компонент включа-
ется в схему и его параметры отображаются под его графическим обозначением. 
Значениями параметров могут быть арифметические выражения. Это особенно 
важно в иерархических проектах для передачи параметров компонентов верхне-
го уровня в компоненты нижнего уровня. Примером правильной записи в ка-
честве значения параметра является выражение x = pi/(2*Param), где Param – па-
раметр, определенный для схемы или для символа верхнего уровня, pi – встро-
енная константа. Основные арифметические операции – сложение (+), вычита-
ние (–), умножение (*), деление (/) и возведение в степень (^). Эти операторы 
предназначены для работы с целыми и вещественными (с плавающей точкой) 
числами. 

В настоящее время все промежуточные вычисления выполняются с двой-
ной точностью, и только по окончании вычислений результат преобразуется к 
типу того параметра, который вычислялся. Следовательно, необходимо соблю-
дать осторожность, например, используя для вычисления целочисленного па-
раметра выражения, оперирующие вещественными числами. Для цело-
численного параметра все промежуточные значения вычисляются с двойной 
точностью, после чего результат приводится к целочисленному значению. 

3.3. Окно моделирования 
Моделирование выполняется из окна схемного редактора. В рабочей об-

ласти размещается необходимый элемент контроля результатов моделирования 
в проекте, определяется имя проекта с данными, которые будут сгенерированы 
при моделировании. Для аналоговых схем используются категории элементов 
контроля: Envelop Simulation и Transient Simulation (для моделирования во вре-
менной области). Все данные, получаемые при моделировании, хранятся как 
Data Set (набор данных). Можно изменить имя проекта до моделирования или 
оставить его по умолчанию, т.е. использовать имя текущего проекта с расшире-
нием .ds. 

 
Рис. 11. Окно моделирования: 

а – информационная панель сообщения об ошибках; 
б – информационная панель хода моделирования 
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Окно моделирования (рис. 11) появляется во время моделирования про-
екта и загружается автоматически. Окно содержит две информационные пане-
ли: Simulation / Synthesis Messages и Status / Summary. В первом окне соответст-
венно отображаются сообщения об ошибках и проблемах, возникающих во 
время моделирования или синтеза, а также причина, по которой возникла та 
или иная ошибка. В окне Status / Summary сообщается о ходе моделирования; 
если моделирование прошло успешно, в нем появляется сообщение Simulation 
finished. 

Отдельные элементы в окне схемного редактора можно деактивировать, 
исключая их из моделирования, но не удаляя из проекта. Для этого нужно на-
жать кнопку  Deactivate на панели инструментов или выбрать пункт меню 
Edit → Component →  Deactivate, затем выбрать отдельный элемент или не-
сколько элементов, которые необходимо деактивировать. Для обратной опера-
ции – активации деактивированных элементов – используется команда Active 
из меню Edit → Component → Activate. 

3.4. Окно отображения результатов моделирования 
Это средство служит для просмотра результатов моделирования. Данные 

могут быть представлены в различных форматах, координатных сетках, можно 
сохранить их в файлах и затем использовать в качестве шаблонов. Открыть ок-
но Data Display можно из главного окна или из окна схемного редактора, вы-
брав пункт меню Window → New Data Display или нажав соответствующую 
кнопку панели инструментов (рис. 12). 

 
Рис. 12. Окно отображения результатов моделирования 

 
В строке-заголовке отображаются тип окна, имя файла и числовой иден-

тификатор. В меню File существуют три команды для сохранения отображае-
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мых данных: Save (сохраняет изменения в текущем файле); Save As (сохраняет 
данные в файле с новым именем); Save As Template (сохраняет некоторую ин-
формацию из области рисования). Автоматически будет создан файл с расши-
рением .ddt, информацию из которого при необходимости можно вставлять в 
любое окно данных. Открыть существующий файл данных в окне Data Display 
можно, выбрав Window → Open Data Display, указав имя файла и нажав кнопку 
OK. Для закрытия окна Data Display нужно выбрать пункт меню File → Close 
Window. Если данные в окне изменились, то система предложит сохранить их. 

 
Рис. 13. Разные виды отображения результатов моделирования 

 
Результаты моделирования сохраняются в специальном файле данных. 

Информацию из этого файла можно просмотреть в окне Data Display (рис. 13). 
В этом окне можно: отображать данные в виде различных графиков и в различ-
ных форматах; вставлять маркеры на графике для чтения данных в точке; запи-
сывать математические выражения, которые позволяют выполнять сложные 
операции над данными; добавлять комментарии и рисованные объекты для 
улучшения документации. 

3.5. Используемые методы анализа 
В данной работе используются два вида анализа. 
Анализ методом огибающей (Envelope Simulation) использует комбина-

цию анализов в частотной и временной областях, что позволяет эффективно 
проводить полный спектральный анализ сложных сигналов, таких как дискрет-
но-модулированные высокочастотные сигналы. Смысл анализа заключается в 
последовательном применении метода гармонического баланса для ряда вре-
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менных точек по несущей частоте на некотором отрезке. Это полезно при про-
ектировании схем и систем, включающих модуляторы/демодуляторы или рабо-
тающих под воздействием сигналов со сложной модуляцией. 

Анализ во временной области (Transient Simulation) позволяет рассчиты-
вать параметры нелинейных устройств методами численного интегрирования 
нелинейных дифференциальных уравнений во временной области, когда эле-
менты устройства моделируются приближенными эквивалентными схемами. 

4. ОПИСАНИЕ МОДЕЛИ РАДИОДАЛЬНОМЕРА 
Модель радара представлена на рис. 14 и содержит передатчик (CW 

Transmitter), цель (Target_Model) и приемник (Single-Stage Receiver). 
Частотно-модулированный сигнал, частота которого изменяется по сим-

метричному пилообразному закону с девиацией частоты DeltaF, формируется 
генератором СW1. 

Частота биений на выходе смесителя (DownConvertor1) определяется 
двумя способами: с помощью частотомера (TF1), измеряющего мгновенную 
частоту (V2) и счетчика (CT1), который считает количество импульсов, посту-
пающих на его вход (V1). Усреднение частоты биений проводится в окне ото-
бражения результатов. При этом Fbcp1 = mean(V2), где mean() – встроенная 
функция усреднения, а Fbcp2 = max(V1)/( Stop_Setup-Start_Setup), т.е. равна ко-
личеству импульсов за время анализа. 

Модель дальномера описывается следующими параметрами: 
− Carrier_Frequency – несущая частота (0,4 ГГц); 
− XMIT_Bandwidth – полоса пропускания фильтра передатчика (0,5*Car-

rier_Frequency) ; 
− Receive_Bandwidth – полоса пропускания входного фильтра приемника 

(0,5*Carrier_Frequency)  ; 
− Transmit_Power – выходная мощность передатчика (1 Вт); 
− Receiver_Gain – коэффициент усиления приемника (60 дБ); 
− DeltaF – девиации частоты (0,2*Carrier_Frequency); 
− mod_frequency – частота модуляции (100 кГц); 
− Low_Bandwidth – полоса пропускания выходного фильтра приемника 

(0,15*Carrier_Frequency); 
− Target_Range – дальность до цели (15 м); 
− Target_Velocity – скорость цели (1 м/с) ; 
− Target_CrossSection – ЭПР цели (1 м2); 
− Step_Setup – шаг изменения времени при моделировании; 
− Stop_Setup – время моделирования. 
В скобках указаны исходные параметры модели. Любой из параметров 

может быть изменен либо непосредственно на поле модели,  либо в окне пара-
метров компонента, которое открывается после двойного клика левой клавишей  
мыши на выбранном элементе или нажатием значка  на панели инструмен-
тов. 
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Рис. 14. Схема частотного радиодальномера 

 
Подробную схему каждого элемента модели можно просмотреть  с помо-

щью кнопок  (развертывание иерархии объекта) и  (свертывание иерар-
хии) или выбрав пункт меню File → Open Desings (Window → Desings Open), 
затем в открывшимся окне (рис.15) выбрать и открыть интересующий  элемент. 

 

 

 
 

Рис. 15.  Окно открытия  
элементов модели 
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5. ЛАБОРАТОРНОЕ ЗАДАНИЕ 
1. Открыть проект distance_meter _prj из директория, указанного препо-

давателем. 
2. В среде ADS в окне схемного редактора подготовить схему 

(design) макета дальномера, использующего частотный метод измерения даль-
ности.  

3. Проанализировать работу дальномера с использованием ADS. Полу-
чить сигналы и их спектры  в контрольных точках схемы. Получить и проана-
лизировать зависимость ошибки измерения дальности от величины измеряемой 
дальности.  

4. Проанализировать работу моделей генератора сигнала (CW1) и модели 
цели (Target1)  

6. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 
1. Установить исходные параметры модели и проанализировать работу 

устройства во временной области, при этом объекты модели TIME_ANALYSIS 
и TRANSIENT должны быть активированы, а объекты ENVELOPE_ANALYSIS 
и ENVELOPE деактивированы. 

2. Начать моделирование командой главного меню Simulate →  Simulate 
или нажать кнопку  Simulate  на панели инструментов. 

3. Наблюдать в окне моделирования отображение процесса выполнения 
работы активных контроллеров, оценку общего времени, затраченного на си-
муляцию, общую оценку результата и сообщения об ошибках. 

По завершении симуляции автоматически открывается новое или подго-
товленное ранее окно отображения результатов моделирования (данных). Фор-
ма представления – таблица или график. Вид графика в прямоугольных коор-
динатах можно выбрать в панели графического представления. Окно отображе-
ния результатов моделирования показано на рис. 16. 

4. Для получения спектра сигналов в окне просмотра выходных данных 
нужно разместить компонент Eqn, описывающую вводимое уравнение: 
spectr_s10=fs(s10,,,,,,,0ms,3ms). Здесь spectr_s10 – имя рассчитываемой спек-
тральной характеристики (назначается пользователем); fs – имя библиотечной 
функции, реализующей фурье-анализ, s10 – имя напряжения в узле, для которо-
го производится вычисление спектра; 0ms, 3ms – начальное и конечное значе-
ния временного интервала для фурье-анализа. Можно изменить интервалы, не 
прибегая к повторному моделированию схемы. Из девяти аргументов функции 
fs() только один – имя преобразуемой переменной – является обязательным. 
Значения необязательных переменных функции fs() могут не подставляться, а 
их место отмечается запятыми. Для получения детальной информации в окне 
Eqn нужно нажать кнопку Functions Help. 

5. Изменяя дальность до цели (Target_Range), получить и проанализиро-
вать зависимость ошибки измерения дальности от величины измеряемой даль-
ности. Сравнить полученную зависимость  с расчетной. 

6. Рассчитать минимальную  и максимальную однозначно измеряемую 
дальность. 
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7. Проанализировать работу устройства методом огибающей,  при этом 
объекты модели TIME_ANALYSIS и TRANSIENT должны быть деактивирова-
ны, а объекты ENVELOPE_ANALYSIS и ENVELOPE активированы. 

8. Результат моделирования получить в окне отображения данных  
(см. рис. 16).  

 

 
 

Рис. 16. Окно отображения результатов моделирования 
 

7. СОДЕРЖАНИЕ ОТЧЕТА 
1. Цель работы и задание. 
2. Краткие сведения о частотном методе измерения дальности. 
3. Графики зависимостей, расчетные параметры, полученные на каждом 

этапе выполнения задания. 
4. Выводы по каждому пункту исследований. 

8. КОНТРОЛЬНЫЕ ВОПРОСЫ 
1. Назначение радиодальномера. 
2. Назовите основные блоки радиодальномера. 
3. На чем основан принцип действия высотомера? 
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4. Перечислите основные тактико-технические характеристики радиовысо-
томера. 

5. В чем заключается частотный метод измерения дальности? 
6. Какие методы, кроме частотного, могут быть также использованы в РТС 

для измерения дальности до цели? 
7. Поясните формулу для определения частоты биений. 
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